cefi

Fiery® E300 Color Server

Utilities



© 2016 Electronics For Imaging, Inc. The information in this publication is covered under Legal Notices for this
product.

45140052
11 May 2016 N O I



Utilities 3

Contents
Contents
INErOdUCHION .. 5
Terminology, conventions, and doCUMENTation r@SOUICES . .. ...ttt ittt et e et 5
Installing user SOftware ... ... ... o 7
Installing user software on a Windows COmMpPULEr . ... . it i e i et et ettt 7
Install user software on a Windows computerfrommedia .............ciiiiiiiiiinin i, 7
Modify user software frommedia . ...t e e e 8
Install user software on Windows from WebTools . ........ ... i i 8
Uninstall user software on WINdOWS . .. ...ttt e e e e e e e e 8
Installing user software on a Mac OS COMPULEr . ...ttt e e et et e ettt ettt e e et 8
Install user software on Mac OS frommedia . ...... ... i e e e 9
Install user software on Mac OS from WebTools .. ... ..ttt e e et 9
Uninstall user software on Mac OS ... ..ottt e e e e e e 10
Using Fiery SOftware Manager ... ...ttt ettt ettt e et et et e ettt ettt e i 10
Command WorkStation ... .. ... 11
Installing Command Workstation . ... ... ..ot it e e e et e e e e 11
Connecting Command WorkStation .. ... ...ttt e e ettt e e e 1
Configure the connection to the E300 ... ..ottt e e e e e et et 12
Using Command WorkStation .. ... ... e e e e e 12
Additional information on Command WorkStation . ........ ... ... e 13
Mixed Media . ... e e 13
DEfiNE @ COVET ottt e e 13
Define media for selected PagES . ...ttt e e 14
INsert blank Pages .. ..o e 14
INSErt 1A . . o e e 15
SOft PrOOf . o e e 16
IMage ENNaNCe ... e e e 16
Image Enhance Visual Editor ... ... . e e e e e e e e 17
NG Y O BT . . ot 17
Troubleshooting CONNECHIONS . . ..ottt et e e e e e e e e e e e e e ettt 17
Command WorkStation does Not respond . ...ttt i e e 18
Create @ oD BITOr FE POt .ottt et ettt e e e et e e e e e 18

Fiery make-ready applications ........ ... . 20



Utilities 4

Contents
Enabling Fiery make-ready applications ... ...... ...t i e e 20
Install a license for your software Option . ... .. . e 21
Activate a Fiery option manually .. ... .. e 21
Install Adobe Acrobat and Enfocus PitStop Edit . ... ..ot i i et et et 22
Fiery make-ready applications help ... ... e e 22
Hot Folders ... 23
Installing Hot Folders . ... o e e e et et e et et et et e e 23
Upgrading from an earlier version of Hot Folders . ... ... . i i e e e i e 23
UsiNg HOt FOlders ..o i e e e e e e e et e e e e 24
WeEbT0O0IS ... 25
Setting UP WebT00ls . .o e e e e e e e e 25
Pop-up Blocker With WebTools ... ... . e e et e e et et e e e e 25
Accessing the WebTools home page . ...t e e e e e e e e 26
Using WebToo0ls . ... e e 26
DOCS ot e e e 27
DOCS 1A .ot t eee 27
Printing and managing Jobs iN DOCS . ... ...ttt i e e e e 27



Utilities 5
Introduction

Introduction

The Fiery® E300 Color Server media pack includes a set of software utilities that allow you to manage the Fiery® E300
Color Server, as well as the print workflow and content of jobs on the xx52ci.

This document provides an overview of how to install, configure, and use the following Fiery® E300 Color Server
utilities:

Fiery Command WorkStation monitors and manages the print workflow of jobs on the Fiery® E300 Color Server.

o Fiery Preview provides a soft proof of each sheet surface of a job before it is processed. The visual interface
changes dynamically to display any changes made in preparing documents for printing.

o Fiery JobMaster provides advanced PDF-based tools for tab insertion, scanning, page numbering, chapter
creation, and late stage editing.

o Fiery Impose applies imposition layouts to jobs for custom printing, binding, and trimming.

o Fiery Compose defines the chapter divisions of a job, specifies ranges of pages on varying types of media, inserts
blank media between pages, and inserts tab media containing text labels.

o Fiery Productivity Package offers additional color and production features for operators (or users with Operator
or Administrator privileges) to monitor and manage the print workflow of jobs.

o Hot Folders provide a simple and automated method of sending print jobs to the Fiery® E300 Color Server across
the network by allowing documents to be dropped into a folder associated with preset print options.

e WebTools manages your Fiery® E300 Color Server remotely from the Internet or your company intranet.

For information about using color management, see Color Printing.

For information about Fiery Productivity Package, see Fiery Productivity Package.

Terminology, conventions, and documentation resources

This document uses the following terminology and conventions to refer to the Fiery® E300 Color Server, printer, and
supported operating systems.

Term or convention Refers to

Aero E300 (in illustrations and examples)

Command WorkStation | Fiery Command WorkStation

Printer xx52ci

E300 Fiery® E300 Color Server
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Term or convention Refers to

Mac OS All supported Mac operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Windows All supported Windows operating systems. For a complete list, see System Requirements in
Configuration and Setup.

n Warning: A warning concerning operations that may lead to death or injury to persons if not performed
) correctly. To use the equipment safely, always pay attention to these warnings.

C Caution: A caution concerning operations that may lead to injury to persons if not performed correctly. To
) use the equipment safely, always pay attention to these cautions.

2 Important: Operational requirements and restrictions. Be sure to read these items carefully to operate the
) equipment correctly, and avoid damage to the equipment or property.

The following documentation resources are available for the Fiery® E300 Color Server.

Resource Description

User documentation Documents in this set: Color Printing, Configuration and Setup, Fiery Productivity Package,
Printing, Utilities

Online help e Help can be accessed directly from each Fiery application or by going to help.efi.com.

e Each help system is available as a printable PDF, accessed from the PDF icon in the upper right
corner of the Help window.

Additional reference

material e Fiery Color Reference - help.efi.com/ref/colorref/en-us/

e Variable Data Printing - help.efi.com/ref/vdp/en-us/
o Workflow Examples - help.efi.com/ref/workflows/en-us/

e  Configure Help - help.efi.com/configure/3.0/en-us/



http://help.efi.com
http://help.efi.com/ref/colorref/en-us
http://help.efi.com/ref/vdp/en-us
http://help.efi.com/ref/workflows/en-us
http://help.efi.com/configure/3.0/en-us
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Installing user software

You can install E300 user software on Windows and Mac OS computers.

Install user software in one of the following ways:

e From the User Software DVD

¢ From the E300, using the Internet or intranet

If earlier versions of E300 user software are installed on your computer, the installer allows you to uninstall those
applications before installing new software.

Note: When you upgrade user software, use the Fiery User Software Installer and follow the instructions by selecting
Modify.

For more information, see Modify user software from media on page 8.

If you do want to uninstall an earlier version of user software, you may want to back up your settings. Back up and
restore of E300 resources and settings is available from Command WorkStation. For more information, see
Configuration and Setup and Command WorkStation Help.

After first-time installation of E300 user software, updates are managed by the Fiery Software Manager application.
For information, see Using Fiery Software Manager on page 10.

Note: Before installing E300 user software, you must disconnect any measurement instrument from the computer.
Otherwise, after installation the instrument may not be recognized by the software.

Installing user software on a Windows computer

All installation of user software on a Windows computer is done with the Fiery User Software Installer.

Before installing the software, ensure that your computer meets the minimum system requirements. For system
requirements, see Configuration and Setup.

The only applications that are not installed by the Fiery User Software Installer are Adobe Acrobat and Enfocus
PitStop, for use with Fiery Impose/JobMaster/Compose. For more information, see Fiery make-ready applications on
page 20.

Procedures describe installing from the User Software DVD, or over the Internet, and also modifying the user
software.

Install user software on a Windows computer from media

1 Insert the User Software DVD into the DVD drive of your computer.
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2 Follow the on-screen instructions.

& Important: Do not attempt to install user software by opening the individual folders for the applications. To
modify or remove user software after you install it on your computer, use the Fiery User Software Installer.

Modify user software from media

1 Insert the User Software DVD into the DVD drive of your computer.

2 In the window that appears, select Modify, Repair, or Remove.
¢ Modify: Allows you to add new program features or remove currently installed features.
¢ Repair: Reinstalls all currently installed program features.

¢ Remove: Removes all currently installed program features.

3 Follow the on-screen instructions.

You can also install the user software from the E300 over the Internet or your company intranet, using
WebTools. Ask your network administrator for the IP address of the E300.

Use your Internet browser to access WebTools. For complete information about browser and system
requirements, see Configuration and Setup.

Install user software on Windows from WebTools

1 Start your Internet browser.

2 Type the IP address or DNS name of the E300.

3 Click the Downloads tab.

4 Click the link for the software that you want to install.

5 Choose Run to open the file or choose Save to save it to your computer.

a) If you choose Save, browse to the location where you want to save the USERSWMI.exe file, and then click
Save.

b) Double-click the USERSWMI.exe file.
6 Type the E300 URL, http://<IP address>, when prompted.
7 Follow the on-screen instructions.
Uninstall user software on Windows

To remove user software after you have installed it on a Windows computer, use the Fiery User Software Installer.

Note: Do not attempt to uninstall user software from the Windows Control Panel.

For information, see Modify user software from media on page 8.
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Installing user software on a Mac OS computer

Installation of user software on a Mac OS computer is done separately for each application.

Note the following:

e When you initiate installation of an application, any previous version installed on the client computer is
automatically removed.

e All applications must be from the same package of software. When you initiate installation of one application
from a package, all applications on the client computer from a different package are removed. You are prompted
to re-install the applications from the new package. If necessary, you can manually uninstall the user software
using the Fiery Software Uninstaller.

Adobe Acrobat and Enfocus PitStop, for use with Fiery Impose/JobMaster/Compose are supplied with your Fiery
Impose/JobMaster/Compose kit and are installed in a separate operation. For more information, see Fiery make-
ready applications on page 20.

Installing and uninstalling user software on a Mac OS computer can be done from the User Software DVD, or over
the Internet or your company intranet. Ask your network administrator for the IP address of the E300

Use your Internet browser to access WebTools on the Internet. For complete information about browser and system
requirements, see Configuration and Setup.

For information about installing printer drivers, see Printing.

Install user software on Mac OS from media

1 Insert the E300 User Software DVD into the DVD drive of your computer.
2 In the User Software window, open the Mac_User_SW folder.

3 Double-click the Fiery Applications.dmg icon.

4 Double-click the icon for the application that you want to install.

5 Follow the on-screen instructions.

Install user software on Mac OS from WebTools

1 Start your Internet browser.

Type the IP address or DNS name of the E300.

Click the Downloads tab.

Click the link for the software that you want to install.
Double-click Fiery Applications.dmg.

Double-click the icon for the application that you want to install.

N & uu A W N

Follow the on-screen instructions.
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Uninstall user software on Mac OS

1 Insert the User Software DVD into the DVD drive of your computer.

2 Double-click the icon for the Fiery Software Uninstaller.

i A W

Drag the Fiery Software Uninstaller icon to your Applications folder.
Choose Go > Applications > Fiery Software Uninstaller.

Select the software that you want to uninstall and follow the on-screen instructions.

Using Fiery Software Manager

Fiery Software Manager is installed automatically by the Fiery User Software Installer and manages any available
updates of the Fiery User Software.

After installation, the Fiery Software Manager icon is displayed by default in the Windows computer task bar or the

Menu bar on a Mac OS computer. You can specify a number of preferences for managing updates.

1 Right-click the Fiery Software Manager icon in the task bar (Windows) or the Menu bar (Mac OS) and select
Preferences.

2 Select one of the following:

Launch at Login (default setting): Fiery Software Manager automatically checks for updates and notifies you.

Download updates automatically: Fiery Software Manager notifies you which versions of applications are
installed and what updates are available.

Show additional features: Installs server updates for Fiery JDF (service technicians only) or downloads server
language packages for additional language support.

Help EFl improve its software: Allows EFI to collect anonymous usage data from Fiery applications.

10
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Command WorkStation

Command WorkStation is a cross-platform application that gives operators the tools to manage jobs on the E300,
and administrators the tools to configure the E300 for printing.

Command WorkStation includes the Job Center for job management, Device Center for server resource
management, and Fiery make-ready applications for complex preparation of jobs for printing.

In the Job Center and Device Center views, the Servers list shows every E300 that you are connected to. You can
switch between servers, and add or remove them from the list. Information is available about consumables on the
printer, tray association status, and errors and alerts.

o Job Center displays the tools for managing jobs in the print queues, and a job preview of processed jobs. The
status of jobs is shown. You can search for jobs and access features from the customizable toolbar.

¢ Device Center gives you access to all of the resources of the E300. From the Device Center, you can access Server
Configuration and tools such as Backup & Restore. You can perform Color Setup, configure Virtual Printers,
manage VDP Resources, and view fonts installed on the E300.

Installing Command Workstation

Install Command WorkStation on a Windows or Mac OS computer with a network connection to the E300.
For a complete list of system requirements, see Configuration and Setup.

The Installer is provided on the User Software DVD as part of the Fiery User Software Installer (Windows
computers) or as a separate application (Mac OS X). To install Command WorkStation, see Installing user software
on page 7.

Connecting Command WorkStation

To use Command WorkStation, you must configure the connection to the E300.

The first time you start Command WorkStation, you are prompted to configure the connection to the E300. You can
also edit the configuration whenever a change to your E300 or network occurs, such as a changed server name or IP
address. If you change E300 Setup information, do so before you reconfigure the connection.

Note: You can connect up to as many as ten different E300s in Command WorkStation. If you try to connect to
more than ten, Command WorkStation may stop responding.

The E300 Configuration page contains information you need when configuring the connection, such as the IP
address of the E300. For TCP/IP installations, you can use the DNS name instead of the IP address. Make sure that
the E300 is registered in a Domain Name Server (DNS) on your network. For more information, contact your
network administrator.



Utilities 12
Command WorkStation

Configure the connection to the E300

Conlfigure the connection from Command WorkStation to the E300.

Before configuring the connection, you must obtain the IP address or DNS name of the E300. Ask your network
administrator for this information.

1

4

Start Command WorkStation:

¢ Windows: Click Start and choose All Programs > Fiery > Command WorkStation 5.

¢ Mac OS: Choose Go > Applications > Fiery > Command WorkStation 5 > Command WorkStation.

Type the DNS name or IP address and click Add to add the server to the Disconnected servers list.

a) If no E300 is found, click the Search icon, search by a range of IP addresses or by the IP address and subnet
mask, and then click Go. Or, select Auto Search. All available servers are listed.

b) To search for a particular server, type the server name in the Filter by keyword field.

¢) Select the E300 that you want to use, click Add, and then click Connect.

Choose Administrator, Operator, or Guest from the User menu and type the appropriate password, if required.
Ask your administrator for the password for the E300 that you want to connect to.

You have the option to save your password by selecting Save password. The next time you log on as that user, the
password is automatically entered. Command WorkStation saves one password per E300 at any one time.

For information about setting passwords and the default Administrator password for the E300, see Configuration
and Setup.

Note: In addition to the three default user names of Administrator, Operator, and Guest, users can login with
their own user names if the network administrator has set them as a member of one of the groups in Configure >
User Accounts.

Click Login.

Command WorkStation is now connected to the E300. You can begin using Command WorkStation to monitor and
manage jobs on the E300.

For information about managing and connecting another E300, see Command WorkStation Help.

Using Command WorkStation

For instructions on using Command WorkStation, features, see the online Help.

The Help menu offers access to the following resources:

Help provides detailed procedural information.
How To accesses the EFI web page, which provides demo scripts and sample files.

What’s New describes the new features of Command WorkStation.
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Additional information on Command WorkStation

Additional information about Command WorkStation features is provided.

The information in the Command WorkStation chapter supplements the Command WorkStation Help.

Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a job, print ranges of pages on varying types of
media, and insert blank media between pages.

If tab printing is supported, you can insert tab media containing text labels.

The following guidelines and restrictions apply to Mixed Media settings:

¢ The Mixed Media dialog box restricts you from specifying settings that conflict with any media, page size, or
finishing settings that have been specified for the job in the Job Properties dialog box or printer driver.

e When two or more Mixed Media settings are in conflict with each other, the Mixed Media dialog box highlights
the setting names in red, signaling you to resolve the conflict.

¢ When you specify print options (in the Job Properties dialog box or printer driver) after specifying Mixed Media
settings, certain print options may conflict with the page-specific Mixed Media settings. You must resolve the
conflict by choosing different print options or removing certain Mixed Media specifications.

e Mixed Media settings affect the use of output color profiles when the Use media defined profile option is
selected in Color Setup. For more information, see Color Printing.

Define a cover

If your E300 and printer support the printing of covers, you can specify a cover media different from that used for
other sections of the job.

1 Select a job in the Held list in Job Center. Do one of the following:
¢ Click Properties in the Actions menu.
¢ Right-click and select Properties.
e Click the Properties icon in the Job Center tool bar.

¢ Double-click the job.

2 Click the Media icon in Job Properties and scroll down to Mixed Media.
3 In the Mixed Media dialog box, click Define Cover.

4 To define identical front and back cover media, select the Apply the same settings for both front and back cover
option. To define media settings for the front or back cover individually, select the Front Cover or Back Cover
option.

5 Choose other settings, as required.
6 Click the Custom button to open the Custom Paper Size dialog box and specify a custom output paper size.

7 Choose the required media from the Media menu.
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Click OK.
Cover media settings override settings defined in the Page/Page Range Media dialog box.

Define media for selected pages

You can define different media for selected pages, or a range of pages.

1

O ®© N o

Select a job in the Held list in Job Center. Do one of the following:
e Click Properties in the Actions menu.

¢ Right-click and select Properties.

¢ Click the Properties icon in the Job Center tool bar.

¢ Double-click the job.

Click the Media icon in Job Properties and scroll down to Mixed Media.
In the Mixed Media dialog box, click New Page Range.

In the Page/Page Range Media dialog box, type pages and page ranges as comma-separated values (for example:
3,9-14,18).

Choose other settings, as required.

If you assign a new media type to the back side of a duplexed sheet, a blank page is inserted to force the assigned
page content to the front side of the next sheet.

Click the Custom button to open the Custom Paper Size dialog box and specify a custom output paper size.
Choose the required media from the Media menu.
Click Add Definition after each media setting that you define.

Click Close to return to the Mixed Media dialog box.

Insert blank pages

You can insert blank pages in your job and assign different media for them.

1

Select a job in the Held list in Job Center. Do one of the following:
¢ Click Properties in the Actions menu.

¢ Right-click and select Properties.

¢ Click the Properties icon in the Job Center tool bar.

¢ Double-click the job.
Click the Media icon in Job Properties and scroll down to Mixed Media.

Click New Insert in the Mixed Media dialog box.

Indicate whether to insert the blank before or after the target page. Define the target page as the first or last page
in the document, or as a specific numbered page.

Choose other settings, as required.
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Click the Custom button to open the Custom Paper Size dialog box and specify a custom output paper size.
Choose the required media from the Media menu.
Click Insert after each blank page that you define.

Click Close to return to the Mixed Media dialog box.

Insert tabs

The Insert Tab feature allows you to automatically insert tab pages throughout a job.

The Insert Tab feature accommodates various sizes and types of tab media stock. You can insert the tab text and
override text attributes on a per-job basis.

Note: When you configure counters for the printer, printed tab pages count as black-and-white pages, provided the
tab text color is set to the default (Black). Expelled tabs are not counted as printed pages.

1

Select a job in the Held list in Job Center. Do one of the following:

¢ Click Properties in the Actions menu.
¢ Right-click and select Properties.
¢ Click the Properties icon in the Job Center tool bar.

¢ Double-click the job.

Click the Media icon in Job Properties and scroll down to Mixed Media.
Click New Tab in the Mixed Media dialog box.

In the Insert Tab dialog, type the number of tab positions included in a complete tab set in the Number of tabs
in a set field.

This specification ensures that tab text is printed in the correct tab positions. For example, tab positions in a set
consisting of ten tabs are distinct from tab positions in a set consisting of five tabs.

Specify other settings as required for the tab stock.

Paper size values refer to the dimensions of the stock, including the tabbed portion.

To specify attributes for the tab text, type the number of tabs in the Number of tabs to insert field, and then click
Insert.

Specify tab text

You can specify what text you want on inserted tabs, and also specify styles.

1

2

3

If you want all the tabs to use the same text attributes, select the Apply the same text attributes for all tabs option
in the Tabs Text area of the Insert Tab dialog box.

Click Insert.

In the Text Attributes column, click the arrows to display the menus for font, size, color, text rotation, and text
alignment, and choose the attributes that you want from each menu.
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4 Indicate where you want each tab inserted in the document.
a) In the Page field, type the page number where you want the tab inserted.

b) Select Before to insert the tab before the page number, or clear this check box.

Note: If you define a tab to be inserted between an odd-numbered page and an even-numbered page in a duplex
job, the tab is inserted after the odd-numbered page on the first sheet, and the even-numbered page is printed
on the next sheet.

5 Type the desired tab text for each tab in the Tab Text field.

To define text attributes for each tab individually, click Text Attributes for that tab.
6 After you type the tab text, click OK to close the Insert Tab dialog box.

7 To modify media settings for the tabs, select the tab description in the Mixed Media Definition list, and then click
Edit.

8 To apply your Insert Tab settings to the document, click OK to close the Mixed Media dialog box and Job
Properties.

Output tray for unused tabs

Unused tabs can be sent to a specific output tray.

For example, if you print a three-tab job and are using tab paper that has five tabs in a set, the fourth and fifth tabs
are unused. To select the output tray for unused tabs, click New Tab in the Mixed Media window, select Output Tray
to Kick Out Unused Tabs, and then choose the output tray from the drop-down menu.

From Insert Tab, specify:
e Number of tabs in the set of tab paper that you are using
e Tab positions

e Page number of tabs

Note: Output Tray to Kick Out Unused Tabs is only available when you print multiple copies for your tab job. You
cannot specify a finisher for the unused tab paper output tray if that finisher is not used for your job.

Soft Proof

Soft Proof allows you to preview print jobs on a monitor.

Use soft proofs to preview the layout and position of elements on the page as they will appear when the job is
printed. Access soft proofing through the Preview window in Command WorkStation. Open a processed, held job in
the Preview window in Command WorkStation, and a raster preview will be displayed. For information, see
Command WorkStation Help or Fiery JobMaster Help.
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Image Enhance

Use the Image Enhance print option to apply photo enhancement to photographic color images on specified pages
or sheets of a job.

& Important: This feature is not used on graphics such as logos or charts.

To turn on this feature, select the Apply Image Enhancement option for a job and specify the pages or sheets to be
affected. This option is located in the Image tab of the printer driver and Job Properties. You can customize Image
Enhance settings from Command WorkStation.

For more information about the Image Enhance print option and how to configure it, see Command WorkStation
Help.

Image Enhance Visual Editor

Image Enhance Visual Editor (IEVE) is an image editing application that provides users with a visual workspace to
adjust individual images in a job.

IEVE is available with Fiery Productivity Package.

You can adjust tone, color, and sharpness, and perform red-eye correction. You can apply the same adjustments to
all images on a page or a range of pages. You can see the effects of your adjustments and fine-tune the appearance of
an image. When you save a set of adjustments as a preset, you can easily apply the same adjustments in the future.

& Important: Adjustments made in IEVE affect the job on the E300 and cannot be applied to the original source
document.

For information about using IEVE, see Fiery Productivity Package.

ImageViewer

ImageViewer allows you to soft proof and adjust colors in a job before it is printed.

Use the preview in ImageViewer on a job to verify job placement, orientation, and content, as well as color accuracy.
If the job contains halftone screened settings, the preview shows a composite view of all separations at the dot level.
You can select to display the plate data for each process color independently or in combination with the other colors,
allowing inspection of individual plate data or a combination of any range of plates. The job must be processed and
held.

ImageViewer is available with Fiery Productivity Package. For information about using ImageViewer, see Fiery
Productivity Package and Fiery Command WorkStation Help.
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Troubleshooting connections

If you cannot connect to the E300 or locate the E300 from your computer, contact the network administrator.

The administrator may need to troubleshoot your network connections and check settings on the servers that you
print to. If settings have changed, it may be necessary to reconfigure the E300 (see Configuration and Setup).

If you can connect to the E300 with another utility, you may need to reconfigure the Command WorkStation
connection to the E300.

If you configured the E300 and set up client computers and network servers according to the instructions in
Configuration and Setup, print a Test Page. If you can print the Test Page but still cannot print a document from a
remote computer, contact your network administrator to troubleshoot the network connection.

If you cannot connect and cannot print a Test Page, check the printer control panel for error messages.
Command WorkStation does not respond

You can try different actions when Command WorkStation does not respond.

If the Command WorkStation windows do not update:

e Log off and then quit Command WorkStation.

e Restart Command WorkStation or restart the computer.

If the Command WorkStation windows do not update or no jobs are displayed, and the mouse has no effect (you
cannot select a job or a window, use a right mouse command, or select a menu item), the E300 is offline or network
communication has failed.

To force an exit from Command WorkStation:

¢ Windows: Press Ctrl-Alt-Delete and use the Task Manager to close Command WorkStation.

e Mac OS X: Choose Apple menu > Force Quit, select Command WorkStation, and then click Force Quit. Or, press
Command+Option+Esc, select Command WorkStation, and then click Force Quit.

e At the E300, disconnect and reconnect the network cable, and then try printing a Test Page or Configuration
page.
o If printing fails, restart the E300.

Create a job error report

If you encounter any errors while processing or printing a job, you can create a job error report in Command
WorkStation for troubleshooting purposes.

The job error report can be sent to technical support.

1 Select ajob in the Printed or Held list in Command WorkStation.

Only one job error report can be created at a time. If multiple jobs are selected in Job Center, the Create Error
Report button is not available.

2 Ona Windows computer, press Ctrl and right-click the job. On a Mac OS computer, press Command (Mac OS)
and right-click the job.

3 Click Create Error Report.
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4 Enter the information in the Create Error Report dialog.

Note: See the "Troubleshooting" chapter in Configuration and Setup for information that we recommend you
provide.
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Fiery make-ready applications

Fiery make-ready applications integrate labor-intensive document preparation activities at both the sheet level and
page level in one visual interface.

These integrated job preparation tools offer the following modes, depending on what client license is available:

e DPreview provides a preview of a job before it is processed and is a standard feature of Command WorkStation.
Users can do a soft proof of each sheet surface of a job before it is processed. The visual interface changes
dynamically to display any changes made in preparing documents for printing.

o Fiery JobMaster provides advanced PDF-based job preparation tools for scanning, tab creation and insertion,
page numbering, chapter creation, and late stage editing. It includes all functions of Fiery Compose.

o Fiery Compose allows you to define the chapter divisions of a job, print ranges of pages on varying types of
media, insert blank media between pages, and insert tab media containing text labels (if the printer supports tab
printing).

o Fiery Impose applies imposition layouts to jobs for custom printing, binding, and trimming. Fiery Impose also
applies impositions to variable data jobs and saves imposed jobs as PDF files.

The Fiery make-ready applications are supported on both Windows and Mac OS computers. For information about
system requirements, see Configuration and Setup.

Enabling Fiery make-ready applications

Fiery make-ready applications are license-protected features of Command WorkStation that work in conjunction
with Adobe Acrobat and the Enfocus PitStop plug-in.

Fiery make-ready applications include Fiery Impose, Fiery Compose, and Fiery JobMaster.
These features are optional upgrade kits for Command WorkStation.

You must install a special license on each computer that runs the software. This section explains how to install the
license and the required software. Note the following:

o The License Activation Code is provided on a card in your kit.

e Adobe Acrobat must be installed on the same computer as the Fiery make-ready application to preview .ps files.
You do not need Adobe Acrobat or Enfocus PitStop to preview .pdf files.

Note: If you are enabling Fiery make-ready software on the E300, you must log on to the E300 with Administrator
privileges and type the appropriate password. To ensure network security, the system administrator may change this
password frequently. Consult your administrator to obtain the password.
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Install a license for your software option

A special license is required to use your software option.
You can install a license in the following ways:

e Automatically, if you are connected to the internet, as described below.
e Manually, if you are not connected to the internet. See Activate a Fiery option manually on page 21.

You can de-activate the license and re-activate it on a different computer. See Fiery Options Help, accessed from the
License Activation window.

1 In Command WorkStation, right-click a spooled job and choose JobMaster, Impose, or Compose.

2 Ifyou are asked whether to activate the option, click Yes.

If you selected Impose, you can select Use Demo or Yes.

To open the License Activation window, you can also select Preview in step 1, and choose Help > Manage License.
In the License Activation window, click Activate.

To agree to the terms and conditions of the license agreement, click Continue.

For License Activation Code, type the LAC you received in your kit, and click Continue.

If the Fiery option name is correct, click Activate.
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Click Finish.

For more information about the activation process, click the Help icon in the License Activation window.

Activate a Fiery option manually

If the computer is not connected to the Internet, you must manually transfer data between the computer and the EFI
licensing website. You will generate a request file, submit it to the EFI licensing website to obtain a license file, and
then use the license file to activate the option.

1 In the License Activation window, click Activate.

Click Continue to agree to the terms and conditions of the license agreement.
Type the LAC in the License Activation Code field, and then click Continue.
Click Continue to proceed with the manual process.

Click Create Request File and save the file.

Copy the request file to a computer that is connected to the Internet.

Open a browser and go to licensing.efi.com.

Click Browse, select the request file, and then click Upload.
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Click Continue.

10 Click Download License File and save the file.

11 Copy the license file to the computer where you first entered the License Activation Code.
12 Return to the Generate License window and click Yes.

13 Click Browse, select and open the license file, and then click Activate.
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14 If the activation requires a restart, you can either click Restart to restart now or click Finish if you want to activate
additional options before restarting. If the activation does not require a restart, just click Finish.

Install Adobe Acrobat and Enfocus PitStop Edit

Install Adobe Acrobat and Enfocus PitStop Edit from your software option kit.

1 If the most recent versions of Adobe Acrobat and Enfocus PitStop Edit are not installed, uninstall the versions
that are currently resident on the computer.

a) Close all open applications.
b) Follow the instructions for your computer for removing programs.

) After you finish uninstalling earlier versions of Adobe Acrobat and Enfocus PitStop, restart the computer.
2 Close all software applications that are currently running on the computer.

3 Insert the Adobe Acrobat/Enfocus PitStop DVD (Windows or Mac OS) into the DVD drive of your computer.

4 If the installer does not start automatically, navigate to the root level of the DVD and double-click Setup.exe
(Windows) or Setup.app (Mac OS).

e Mac OS X: Click Install and follow the on-screen instructions.

¢ Windows: Select the language and click Next.

The software option that you purchased is now fully enabled.

Fiery make-ready applications help

Fiery make-ready applications help is accessed from the application window.
Fiery make-ready applications include Fiery Impose, Fiery Compose, and Fiery JobMaster.

The Help menu offers access to the following kinds of help:
¢ Help provides procedural information.
¢ How To accesses the EFI web page, which provides demo scripts and sample files.

¢ What's New describes the new features of Command WorkStation.
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Hot Folders

Hot Folders provide a simple and automated method of sending print jobs to the E300 across the network. You drag
documents to a folder that stores and reuses preset print options for printing PostScript and PDF files on the E300.

This feature is part of Fiery Productivity Package, which is an option.

With Hot Folders, you can do the following:

e Create special folders (hot folders) that assign specific print settings and print queues to jobs.

e Print jobs to the E300 by dragging and dropping them onto hot folders on your computer’s desktop.

e Monitor the status of jobs sent to hot folders.

Installing Hot Folders

Hot Folders is part of the Fiery Extended Applications Package.

To install Hot Folders on a Windows computer, see Installing user software on a Windows computer on page 7. To
install Hot Folders on a Mac OS computer, see Installing user software on a Mac OS computer on page 9.

Upgrading from an earlier version of Hot Folders

Hot Folders includes a Migration Assistant that detects an earlier version of Hot Folders and upgrades any existing
Hot Folders settings to work in the latest version.

The migration takes place only once during the installation of Hot Folders or Command WorkStation. The summary
in the Migration Assistant window indicates whether or not a Hot Folder transferred successfully to the latest
version, and in case of failure, allows you to retry once during installation without exiting the Migration Assistant.

1 Install Hot Folders and allow the Migration Assistant to detect the earlier version.

Note: The Migration Assistant window only appears if an earlier version of Hot Folders is installed. (Earlier
versions include the following: on Windows, all 2.x versions; on Mac OS, all 2.x versions.)

2 Click OK and follow the on-screen instructions.

Note: Do not click Cancel when migration is in progress. Canceling the operation may cause permanent damage
to the Hot Folders being upgraded.
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3 Check the summary in the Migration Assistant window.

If migration is successful, the successful icon is displayed next to each Hot Folder. If migration fails, or only
partially succeeds, the failed icon is displayed next to the Hot Folders that failed to migrate, with any details
highlighted in the lower pane.

4 In case of failure, click Retry to attempt migration again before exiting the Migration Assistant.
Note: Retrying generates a new summary, checking only the files that failed.

5 Click OK.

Using Hot Folders

For instructions on how to use Hot Folders features, see the Help provided with the software.
After Hot Folders is installed, a Hot Folders icon appears on the desktop of the client computer.
You can use file format filters with Hot Folders. For information, see Hot Folders Help.

If Fiery Productivity Package is installed and enabled on the E300, you can use additional file format filters with Hot
Folders. For information about using these file format filters, see Fiery Productivity Package.



Utilities 25
WebTools

WebTools

WebTools consists of several utilities that allow you to manage your E300 remotely from the Internet or your
company intranet.

The E300 has a home page, where you can select the following WebTools:

¢ Home provides current information about the jobs processing and printing on the E300.

¢ Downloads allows remote users to download installers for user software directly from the E300.
e Docs allows remote users to access jobs on the E300 over the Internet or intranet.

¢ Configure allows the E300 administrator to view and modify Setup options remotely from a Windows or Mac OS
computer.

Setting up WebTools

WebTools are accessed through the home page of the E300 web site and do not require special installation. However,
WebTools do require initial setup by the E300 administrator.

To enable network users to access and use WebTools, the administrator must set specific options in Network Setup
and Printer Setup. For information about these specific Setup options, see Configuration and Setup.

The administrator must prepare each user computer to communicate with the E300 over the Internet or intranet.
1 Enable TCP/IP networking.
2 Make sure that the Windows or Mac OS computer has a valid, unique IP address.

3 Make sure that a supported Internet browser is installed on the computer.

For more information about supported browsers, see Configuration and Setup.
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Pop-up Blocker with WebTools

Pop-up Blocker is turned on by default in some versions of Internet Explorer on Windows computers. With this
function turned on, a warning message appears when you attempt to access WebTools, and access to WebTools is
denied.

To gain access to WebTools, do one of the following:

o Change the Pop-up Blocker setting by clicking the warning message and choosing one of the selections that
appears.

¢ Turn off Pop-up Blocker in the Internet Explorer Tools menu.

If your browser has the advanced Internet option enabled to display notifications about script errors, it might display
a warning window before displaying a Help file. To avoid the warning window, clear the “Display a notification about
every script error” option on the Advanced tab in the Internet Options dialog box. A warning message might also
appear in the Status bar, but the content of the Help file is not affected by this error.

For more information, see Internet Explorer Help, or the documentation that accompanies the Windows operating
system.

Accessing the WebTools home page

Use your Internet browser to access WebTools.
For complete information about browser and system requirements , see Configuration and Setup.

1 Start your Internet browser.
2 Type the IP address or DNS name of the E300.

3 Click the WebTools tab that you want to use.

Using WebTools

The following sections describe how to use the WebTools.

Home

Home lets you view processing and printing status on the E300. If you wish, you can specify how often printing and
processing information is updated by selecting a time interval from the Refresh Status menu.

Downloads

Downloads allows you to download installers for user software directly from the E300.

Docs

Docs allows you to access jobs on the E300 over the Internet or intranet.
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You can:

o Control and modify jobs.
e Submit jobs to the E300.

Configure
Configure allows the E300 administrator to view and modify Setup options remotely.

To use Configure, make sure you complete the procedures described in Setting up WebTools on page 25.

Docs

Docs allows you to access jobs on the E300 over the Internet or intranet.

You can:

o Control and modify jobs.
e Submit jobs to the E300.

By default, three levels of users are set up for Docs: admin, operator, and guest. Three tabs are available in Docs.
Some tabs require access privileges defined by an administrator in setup. Ask your administrator for your level of
access and any required password. For information about access levels, see Configuration and Setup.

Docs tabs

Access to the tabs and functionality in Docs is determined by your level of access: Administrator, Operator, or Guest.

e Printed Docs - displays jobs printed to the E300. Only Administrators and Operators logged in to Docs have
access to all printed jobs on the E300 from the Printed Docs tab. Guests and users see only their own jobs from
the Printed Docs tab.

e Held Jobs - displays processed and held jobs on the E300. Only Administrators and Operators logged into Docs
have access to the Held Jobs tab.

Printing and managing jobs in Docs

You can print, import, rename, or delete a job in WebTools Docs.

The actions described below are available from both tabs in Docs.

Printing a job

Select one or more jobs and click the Print icon to display the file name, thumbnail preview (if available), and an
option to specify the number of copies for each job in the Print window.

Cancel printing by using the Cancel button in the Print window. Canceling the job from the Print window
automatically returns you to the page from which the Print action was selected.

Importing a job

Click the Import icon to specify a job to import to the E300. You can import the job to any E300 published queue
(including virtual printers, if it is supported on the E300).
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Renaming a job

Select one or more jobs and click the Rename icon to rename the job(s). Job names must be unique.

Deleting a job

Select one or more jobs and click the Delete icon to delete the files from the E300.
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